Sage Estimating (SQL) v19.12

Release Notes

July 2020
Contents

Version 19.12 Release Notes ................................................................. 1
  Installation Notes ........................................................................... 1

New Features and Enhancements ......................................................... 2
  Integration with Sage 300 Construction and Real Estate Project Management ........................................ 2

Fixes Since the Previous Version .......................................................... 3

Revisions to Version 19.12 ................................................................. 4
  Update 2 (Build 19.12.2007.141, July 2020) ..................................... 4

Known Issues .................................................................................... 6
  SAP Crystal Reports compatibility with other Sage programs ............... 6
  Problem with migrated standard databases and estimates that used a job cost interface .................. 6
  Checking in a Standard Database from the Database Editor Closes the Database for Concurrent Users ................................................................................................................................. 7

Need help? ....................................................................................... 8
  Submitting Enhancement Requests .................................................. 9
Version 19.12 Release Notes

This document provides important information regarding new features and changes in your Sage Estimating 19.12 software. Read these release notes carefully before installing Sage Estimating 19.12.

Installation Notes

System Requirements

For current information about supported operating systems, Internet browsers, Microsoft® SQL Server®, and other software, and about system requirements for servers and client workstations, refer to our Knowledgebase article ID 101824, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=101824.

Installing Sage Estimating

Refer to the Installation and Administration Guide for complete instructions on installing the software and migrating or upgrading your data.

Before Installing

**Important!**

- Microsoft .Net 4.6.2 is required for Estimating. If it is not already installed on your computer, the Estimating installation will require a restart. If you prefer not to restart when installing Estimating, first install .Net 4.6.2 from the Prerequisites folder (in the Install folder), and then restart your computer before installing Estimating.

- If you are upgrading to version 19.12 and you are using third-party software that integrates with Sage Estimating, check with the third-party software vendor to ensure that their software is compatible with version 19.12 before you upgrade.
New Features and Enhancements

Integration with Sage 300 Construction and Real Estate Project Management

With Sage 300 Construction and Real Estate version 18.4, scheduled for release in December 2019, you will be able to import data from estimates into Project Management change requests.

For information about importing estimate data into change requests, see the Sage 300 Construction and Real Estate help.
Fixes Since the Previous Version

Version 19.12 includes the following fixes:

- **In the spreadsheet:**
  - You can again use a range for repricing or to clear prices.
  - When you create a new WBS code, it will be visible by default in spreadsheet sequences that include it.
  - Notes you add to items and overlines now use the format of the row that they are embedded in as the default formatting.
  - When you sort items within overlines on the spreadsheet, negative values appear in the correct order.
  - Locked columns no longer allow quantity and unit columns to be separated.
  - You no longer receive an error message when you open an estimate that has only excluded items.
  - If you edit an overline takeoff quantity manually, the Ctrl+Z and Ctrl+Y shortcut key combinations work as expected if you need to undo and then redo your changes.

- **For Sage Estimating reports:**
  - Variance Report layouts that use the Print Estimate Totals option show totals properly.
  - On the Standard Estimate report:
    - You can sort by WBS code.
    - Details include phase information.
    - The Totals line no longer wraps inappropriately.
  - Adding an element to a sort in the Spreadsheet report options makes that field visible on the report.
  - If you hide a sort field on the layout for a Spreadsheet report, the report no longer forces that field to be visible.
  - Generated addons are rounded and allocated properly on reports.
  - The **Totals** page of the Spreadsheet report now prints correctly when it extends onto a second page.
Revisions to Version 19.12

This section describes enhancements and fixes we have included in revisions to the software since releasing version 19.12.

Note: Each update is cumulative. That is, each successive update includes all the fixes and enhancements provided in previous updates as well as additional fixes and enhancements in the current update.

Update 2 (Build 19.12.2007.141, July 2020)

Fixes

Update 2 includes the following software fixes:

- When you import multiple estimates from a group of estimates that you exported together in a previous version of Estimating (SQL), all the estimate information is imported correctly.

  If you imported estimates from a group of exported estimates before this update, follow the steps outlined in Knowledgebase article 105869 to fix the imported estimates.

- Estimating no longer becomes unresponsive when you try to rename a duplicate item that you copied and pasted into the spreadsheet.


Enhancements

Update 1 includes the following enhancements:

- In the Database Editor, if no phases or items exist in a database, the program inserts a sample phase and item in the grid.

- Default formulas are available for new standard databases that you create.

- The Means Integrator has been improved to calculate better factored prices and productivity for a few Construction Knowledgebase (CK) items.
Fixes

This update also includes the following software fixes:

- Upgrading prices using Means Integrator no longer changes crew pricing methods incorrectly.
- The Crew Analysis report again displays summary level totals.
- Item descriptions for one-time items appear correctly on the Variance and Comparison reports.
- Totals are no longer cut off in the Alternate Summary window.
- Newly created assemblies now combine correctly in a Combined Assembly sort sequence.
- Spreadsheet reports you print from the Takeoff Order tab appear correctly.
- When you collapse a spreadsheet and then print the Spreadsheet report, the location is displayed in the correct cell in the report.
- An interruption when copying an estimate no longer locks the source estimate.
- We have fixed an issue that caused an index corruption error during migration.
- Using a Bid Grid to switch from self perform to subcontract and then back to self perform no longer incorrectly changes an item’s equipment amounts.
Known Issues

SAP Crystal Reports compatibility with other Sage programs

Version 19.12 uses the SAP Crystal Reports Runtime version 13.0.22, which is not compatible with Crystal Reports used in these versions of other Sage programs:

- **Sage 300 Construction and Real Estate v17.1 and v18.1.**
  
  To ensure that you can run and print your Sage 300 accounting reports, you must use Sage 300 Construction and Real Estate v18.2 or later with Sage Estimating v19.12.

- **Sage Fixed Assets 2018.0.**
  

For more information, see Knowledgebase article KB 93436.

Problem with migrated standard databases and estimates that used a job cost interface

If you migrated a standard database or an estimate that was integrated with job cost in Estimating (Pervasive), you need to perform a few additional steps to reintegrate the standard database or estimate in Estimating (SQL).

**Important!** Until you perform the following steps, you will receive a Job Cost Interface Failure error when you try to edit job cost settings for a standard database or an estimate that was integrated with job cost in Estimating (Pervasive). Also, you will not be able to use the standard database with new interfaced estimates in Estimating (SQL).

Before you start

You need to be assigned to a role with Run Management Console, Edit Standard Databases, Edit Standard Database Settings permissions, and have Edit access to the estimates to use the job cost system setup.
For each migrated standard database that used a job cost interface in Estimating (Pervasive):

1. In the Estimating Management Console, click Standard DB on the ribbon.
2. In the Standard Database Catalog, select the migrated standard database.
3. In the details pane to the right, click [Edit]
4. In the Job Cost Information section:
   a. For the Job cost system name, select either None or Text.
   b. Click [Save].
   c. For the Job cost system name, select Sage 300 Construction or Sage 100 Contractor, depending on the application from which you migrated the estimate.
   d. Click [Setup], and then enter the job cost settings required to reintegrate the database with Sage 300 Construction and Real Estate or Sage 100 Contractor.
5. Click [Save].
6. Repeat steps 2 through 5 for each migrated estimate that used the job cost interface in Estimating (Pervasive).

Note: To edit estimates, you must first click Estimates on the ribbon, and then (in step 2) you select the estimate from the Estimate Catalog.

Checking in a Standard Database from the Database Editor Closes the Database for Concurrent Users

You can work on a Standard database in the Estimating Database Editor while other users perform takeoff using the same database in the Sage Estimating program.

When you try to check in the Standard database while other users have the database open, you receive a warning that if you continue to check the file in, there may be unpredictable results for the concurrent users.

If you continue to check the file in despite the warning, the Estimating program stops working for the other users. However, the data is not corrupted and the Estimating program is not damaged.
# Need help?

<table>
<thead>
<tr>
<th>Get help by:</th>
<th>Recommendation*</th>
<th>To access:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reviewing in-product help</td>
<td>View information about the current window as well as procedures for using</td>
<td>Click the Help button or icon, or press [F1] to display the Help topic for that window.</td>
</tr>
<tr>
<td></td>
<td>Estimating.</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Searching the Knowledgebase</td>
<td>Search the Sage Knowledgebase, which provides 24/7 access to support articles as well as the latest software downloads and updates.</td>
<td>Visit the Knowledgebase at <a href="http://www.sageKB.com">www.sageKB.com</a></td>
</tr>
<tr>
<td>Asking the community</td>
<td>Join industry peers, certified partners, and Sage pros online 24/7 in Sage City—the best place to ask questions and share product experiences, tips, and tricks.</td>
<td>Visit the General Estimating forum at <a href="http://www.SageCity.com">www.SageCity.com</a></td>
</tr>
<tr>
<td>Checking the latest product alerts</td>
<td>Keep up with the latest product information in the Sage City Announcements, News, and Alerts forum.</td>
<td>Visit <a href="http://www.SageCity.com">www.SageCity.com</a></td>
</tr>
<tr>
<td>Submitting a web ticket</td>
<td>Submit your issue directly to our support team using Online Case submission.</td>
<td>Visit <a href="https://customers.sagenorthamerica.com/irj/portal/anonymous/login">https://customers.sagenorthamerica.com/irj/portal/anonymous/login</a></td>
</tr>
<tr>
<td>Get help by:</td>
<td>Recommendation*</td>
<td>To access:</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exploring training options</td>
<td>Learn how to harness the full power of your software through videos and classes at Sage University.</td>
<td>Visit <a href="http://www.SageU.com">www.SageU.com</a> You can also get access to Sage University from the Estimating File menu by selecting <code>Help &gt; Sage University</code>.</td>
</tr>
</tbody>
</table>

*Not all options are available for all products. Customer Service hours vary by product line. Access to some resources require an active Sage Business Care support plan.

**Submitting Enhancement Requests**

We want to hear your suggestions for improving the software. To send us your comments, click on the File menu button and then select `Help > Submit Product Idea`. 